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http://support.automation.siemens.com/WW/view/en/41887492
 
 
 
 
 
 

问题: 
SINAMICS G110D 中，用于控制、诊断和参数化的功能块使用的是 AS-Interface 接口吗？  

 
答案: 
SINAMICS G110D 设计可以用做在 AS-Interface 接口下运行。此方式下，可以通过“参数映

射”或者扩展过程映像区选择不同的诊断方式，而且可以通过 AS-Interface 进行控制和参数化。  
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1 概述 
请查阅参考手册“Systems AS-Interface - IO-Link – PROFIBUS” 来熟悉 AS-Interface 
技术 
http://support.automation.siemens.com/WW/view/de/36185027 
相关链接在 7.1 章节 
 
 

1.1 范围 

在此操作指南中的功能块是用于控制和参数化SINAMICS G110D AS-i 变频器的。它

们兼容与函数调用“ASi_3422 (FC7)” 一起使用的AS-Interface 主站。这些是通讯处

理器 CP34x-2(P) 和西门子PROFIBUS DP/AS-I – Link。 

这些功能块不能用于IE/AS-i Link PN IO – 同样可在此AS-Interface 主站文件中见

到。 

 

1.1.1 CPUs 

所有 S7-300/400 均能使用。 

 

1.1.2 AS-i 主站 

功能块可在下列西门子 AS-Interface 主站或通讯处理器中使用:  
 
表 1-1  AS-i Master 

通讯处理器 订货号 可用功能块 
CP 342-2 AS-i (no B addressing) 6GK7 342-2AH0x-0XA0 FC 143/144/243/244 

CP 343-2 AS-i 6GK7 343-2AH0x-0XA0 FC 143/144/243/244, 
FB 243/247/248 

CP 343-2 P AS-i 6GK7 343-2AH1x-0XA0 FC 143/144/243/244,  
FB 243/247/248 

DP/AS-i Link   

DP/AS-i Link 6ES7 156-0AA0x-0XA0 FC 144/145/146/244/245/246,
FB 247/248 

DP/AS-i Link 20(E) 6GK1 415-2AA0x FC 144/145/146/244/245/246,
FB 247/248 

DP/AS-i Link Advanced 6GK1 415-2BAx0 FC 144/145/146/244/245/246,
FB 247/248 

 
 
 

1.2 功能性 

根据规范 3.0，SINAMICS G110D 配备两个 AS-i 从站 (从站 1 and 2),。通过参数

p2022 可以选择是两个从站（p2022=2）或者只有从站 2(p2022=0)。 
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1.2.1 G110D 作单从站 

如果G110D作为单从站操作，只有基本的控制和状态功能可以使用。输入和输出区

各有 4 位过程映像可以使用。AS-i 主站B区寻址是不可能的。参数映射功能在标准

块M200D中被用于诊断（36846576）。 

1.2.2 G110D 作双从站 

作为双从站，驱动器使用两个 AS-i 站地址. 应用于带有 A/B 转换功能的 AS-i 主站，

地址范围最大到 62 个节点。因此，最多有 31 台 G110D 能够运行在一个 AS-
Interface 主站下。 

在这种方式下，G110D 还有一个串行通道 (CTT2)，当使用功能块FB47 和 FB48
时，可以进行参数化。串行通道总是在输入输出区使用 2 Bits。使用FC7 ASi_3422
通讯功能块时，自身会调用系统功能 SFC58 and SFC59。取决于CPU利用率，同时

调用这些系统功能被严格限制(15364459)。 

作为标准，任何 AS-i 从站通过 4 Bits 被分配地址和分析。由于串行通道和 A/B 切换

的原因，虽然驱动器有两个从站，但只有 4 位控制字和 6 位状态字保留。除了输入

和输出之外，过程映像区还提供模拟量通道。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://support.automation.siemens.com/WW/view/de/36846576
http://support.automation.siemens.com/WW/view/de/15364459
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1.3 可用的功能块 

功能块库 DRVASIS7 包含可对 SINAMICS G110D 进行控制和参数化的功能块。控

制机制的实现基于工厂复位，因此不允许有任何修改。这些功能块并非强制集成或

运行在 S7 环境下。 
表 1-2 S7 功能块总览 
No. 描述 注释 
FC7 ASi_3422 Communication with the AS-i master 
控制, 单从站 
FC143 G110D_ASI1_CTRL_343 Control, G110D with CP34x (only A channel) 
FC144 G110D_ASI1_CTRL Control, G110D general 
FC145 G110D_ASI1_CTRL_CLC Control, G110D in the classic sorting type 
FC146 G110D_ASI1_CTRL_LIN Control, G110D in the linear sorting type 
控制, 双从站 
FC243 G110D_ASI2_CTRL_343 Control, G110D with CP34x (only A channel) 
FB243 G110D_ASI2_AUX_343 Help FB for FC243 (B channel and analog 

values) 
FC244 G110D_ASI2_CTRL Control, G110D general 
FC245 G110D_ASI2_CTRL_CLC Control, G110D in the classic sorting type 
FC246 G110D_ASI2_CTRL_LIN Control, G110D in the linear sorting type 
参数化 
FB247 G110D_ASI2_WR_DS Load data set into G110D  
UDT247 G110D_ASI2_DS_CONF Data set structure for FB247 
FB248 G110D_ASI2_RD_WR_PAR G110D read/write parameters 

 

1.4 所需软件 

所需 S7 工程软件的版本取决于所使用的 AS-I 主站，请查阅相关文档。推荐版本是

STEP7 V5.4 – SP4 或更高。 

还需要调试 SINAMICS G110D 的软件 STARTER V4.1.5.1 (或更高) 。此软件在西

门子支持主页上可免费下载。 
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2 调试 SINAMICS G110D 

2.1 创建项目 

既可在 STARTER 中单独创建项目，也可在 SIMATIC manager 中创建一个集成的

项目。在 STARTER 中，可以在“Project > New” 下选择存储文件夹，然后选择

“Insert single drive unit（插入单驱动单元）”。或者你可以通过“Project > 
Accessible nodes” 方式来把驱动器合并进项目里。 
图 2-1 创建 STARTER 项目 

 
如果你想把驱动器集成在 SIMATIC 项目中，你可以在 SIMATIC 下通过“Insert > 
Program > SINAMICS” 插入 G110D。 
 
图 2-2 集成在 SIMATIC 项目 

 
 
在 STARTER 中通过打开“Commissioning”可进行更进一步的配置。. 
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2.2 在线连接 

 

参数化和调试使用串口和USS协议。连接G110D有两种接口电缆可用。 

 
表 2-1 接口电缆 

接口 订货号 
RS232 3RK1 922-2BP00 
USB 6SL3555-0PA00-2AA0 

 
STARTER 中，你可以通过“Options > Set PG/PC interface”选择和配置连接。

STARTER 与 SIMATIC manager 使用同样的接口设置。万一 PC Com 口 (USS)不
可用，还需要添加接口。G110D 默认波特率是 38400bps，USS 地址为 0。 

 
通过 “Project > Connect to target system” 可以建立在线连接。 
图 2-3 Set PG/PC 接口设置 

 
 
为了在驱动器和 SPS 之间同时建立两个在线连接 (例如，通过 Profibus 或者

PROFINET ) 请在“Options > Settings > Access point”下选择 PC Com port。 
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图 2-4 可选接入方式 

 
 
对于此接入点，之前说明的 PC COM 口设置依然有效，而且必须用同样的方法设

置。然后，你可以把 PG/PC-Interface 设回成 PROFIBUS 或者 PROFINET。 

2.3 参数化 

 

你可在“Configuration”下通过向导进行初次调试。 

可通过“Configuration”或专家参数列表进行更进一步的调试。 

 

图 2-5  
调试向导与专家参数列表 
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2.4 寻址 

可通过 AS-i 地址编程器(订货号: 3RK1904-2AB01)或专用参数设定 G110D 地址。使

用 AS-i 地址编程器时，不需要在线连接。当通过参数设定时，需要和驱动器建立在

线连接，通过专家参数列表中的 p2021[0] （从站 1）和 p2021[1]（从站 2）输入地

址。单从站（p2022[0]）和双从站（p2022[2]）操作是有区别的。地址格式必须是

16 进制的格式。单从站和双从站的信息在 ProdIS ： 44855259 中有提供。在双从

站模式， 

如果从站被分配到 B 区域，必须增加 32 (20Hex) 的偏移量。在下例中，地址 31 (B 
区) 和 10 (A 区) 被分配。 
 
图 2-6 AS-i 从站设定地址 

 
 
地址总是永久的存放在 EEPROM 中，所以即使主程序被中断，他们也会永久保

存。. 
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3 配置 S7-Project 

3.1 AS-i 主站工程 

应用 AS-i 主站必须在 HW config 中工程化。请遵照下列相应 AS-i 主站的指示。 

3.2 AS-i 从站工程 

像其他 AS-i 从站一样，不必强制性的在 HW Configuration 中建立 SINAMICS 
G110D 工程。AS-i 从站由 AS-i 主站管理。 

你可在“Object properties > Slave configuration”下进入已有从站。你还可以在文件

夹 “AS-i slaves options”导入现有拓扑。在操作时 CPU 必须是 STOP 模式。 

当拓扑被编译且装载入 CPU 后，此配置具有优先级。目标拓扑和当前拓扑必须匹

配，否则 CPU 会报错。只在空从站配置下，AS-i 主站才能调整目标配置和当前配

置。请查阅相关文档进行配置调整。 
 
图 3-1  AS-i 主站 CP 343-2P 硬件配置 

 
 
 



通过过程映像区直接控制 
 

 

 

12 
Operating instruction and Function block library DRVASIS7 for SINAMICS G110D AS-i

Version 1, Item-ID: 41887492
 

4 通过过程映像区直接控制 
SINAMICS G110D 也可以不用下述功能块进行控制。过程映像区的输入输出地址范

围可从 HW configuration 获得。 

4.1 单从站的标准过程映像 

典型的 AS-i 单从站提供 4 位去控制或传送状态。 
 
表 4-1 slave 2 > master 的标准过程映像 
AS-i bit 含义 描述 

0: 驱动没有准备好 DI0 驱动准备好 
1: 驱动准备好 
0: 驱动没有运行 DI1 驱动运行 
1: 驱动正在运行 
0: 数字量输入没有激活 DI2 数字量输入 0 状态 
1: 数字量输入激活 
0: 数字量输入没有激活 DI3 数字量输入 1 状态 
1: 数字量输入激活 

 
表 4-2 master> slave 2 的标准过程映像 

描述 AS-i bit 含义 
 DO3 DO2 DO1 DO0  

0 0 0 0 没有行进命令 
0 0 0 1 固定频率 1 
0 0 1 0 固定频率 2 

DO0 控制位 0 

0 0 1 1 固定频率 3 
0 1 0 0 固定频率 4 
0 1 0 1 固定频率 5 
0 1 1 0 固定频率 6 

DO1 控制位 1 

0 1 1 1 固定频率 7 
1 0 0 0 固定频率 8 
1 0 0 1 固定频率 9 
1 0 1 0 固定频率 10 

DO2 控制位 2 

1 0 1 1 固定频率 11 
1 1 0 0 固定频率 12 
1 1 0 1 固定频率 13 
1 1 1 0 固定频率 14 

DO3 控制位 3 

1 1 1 1 故障确认 /OFF2 
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4.2 双从站的标准过程过程映像 

任何 G110D 都有 6 个输入和 4 个输出。可从下表获知每个信号的含义。画阴影的信

号不能直接通过过程映像使用,但是可以通过参数化块 FB247/248 使用。. 
表 4-3  slave 1 > master 的标准过程映像 
AS-i bit 含义 描述 

0: 数字输入未激活 DI0 数字量输入 2 状态 
0: 数字输入激活 
0: 数字输入未激活 DI1 数字量输入 3 状态 
0: 数字输入激活 

CTT2 接收器 串行通道时钟信号  DI2 
时钟  
CTT2 接收器 串行通道数据信号  DI3 
数据  

 
表 4-4   slave 2 > master 的标准过程映像 
AS-i Bit 含义 描述 

0: 驱动没有准备就绪 DI0 准备就绪 
1: 驱动准备就绪 
0: 驱动没有运行 DI1 驱动运行 
1: 正在运行 
0: 数字量输入没有激活 DI2 数字量输入 0 状态 
1: 数字量输入激活 
0: 数字量输入没有激活 DI3 数字量输入 1 状态 
1: 数字量输入激活 

 
表 4-5 master> slave 1 的标准过程映像 
AS-i bit 含义 描述 

CTT2 发送器 串行通道时钟信号  DO0 
时钟  
CTT2 发送器 串行通道数据信号  DO1 
数据  
快停失效 0: 快停激活 DO2 
 1: 快停未激活 
A/B 选择 0: A 区激活 DO3 
 1: B 区激活 

 
表 4-6 master> slave 2 的标准过程映像 
AS-i bit 含义 描述 

DO2 DO1 DO0  
0 0 0 没有行进命令 

DO0 Control bit 0 

0 0 1 固定频率 1 
0 1 0 固定频率 2 
0 1 1 固定频率 3 

DO1 Control bit 1 

1 0 0 固定频率 4 
1 0 1 固定频率 5 
1 1 0 固定频率 6 

DO2 Control bit 2 

1 1 1 故障确认 /OFF2 
0: A 区激活 DO3  A/B 选择 
1: B 区激活 
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4.3 双从站 AS-i 模拟量 

当使用一个 DP/AS-i Link 主站时，模拟量可以并入过程映像。可以通过配置相应从

站的对象属性获得。使用功能块 FB243 可以读取和发送 CP34x-2(P)的模拟量。 
 
图 4-1 AS-i Master DP/AS-i Link 的硬件配置 

 
 
参数 p2061[0] and p2061[1] 决定值的发送，而 PLC(这里为 PEW256/258)的外设映

像存储这些值。变频器内部使用参数 r2062[0] and r2062[1] 来接收数据

( PAW256/258)。 
 
表 4-7 Slave 1 > Master 的标准模拟量值 
AS-i Bit 含义 描述 

输出频率实际值 标准值 (16 Bit) AI0 
参数 r0021  
输出电流实际值 准备值 (16 Bit) AI1 
参数 r0027  
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4.3.1 模拟量值标准化 

SINAMICS G110D 有两路模拟输入和模拟输出。每个模拟通道提供 16Bit （字）的

值，这些值通过相关的参考参数进行标准化。 
表 4-8 相关参数 

参数 参考值 单位 
p2000[0…2] 频率 赫兹[Hz] 
p2001[0…2] 电压 伏特 [V] 
p2002[0…2] 电流 安培 [A] 
p2003[0…2] 转矩 牛米 [Nm] 
p2004[0…2] 功率 千瓦 [kW] / 马力 [hp] (取决于 p0100) 

 
一个字的范围从 0 到 65.536。G110D 根据下表对提交的值标准化。 
表  4-9  

数字值 比例值 
0 – 32.767 0% – 200% 
32.768 – 65.536 -200% – -0% 

 
为了得到绝对值，你必须把参考参数 ( 值为 100 与比例值相乘。 

例如： 

G110D 通过 AI0 通道提供实际输出频率 (p2061[0] = r0021)。 

将会接收到数字量 24.574，这等于比例值 150%与 p2000 参考值相乘。对照 50Hz
的参考值，可得出此为输出频率 75Hz。如果改变方向(等于 -150%)，将会接收到数

字量 40.960。.  
 
 

4.4 快停功能 

此功能典型应用于运输的简单配置。优点在于高重复性，此独立于任何 CPU 或者现

场总线循环时间。 

G11D 本身的数字输入可以连接一个信号用来中断 ON 命令。参数 p0701 和 p0702
必须设置成 22 和 23。通过参数 p0886 可以选择快停是沿触发还是电平触发。 

行进命令一直使用控制位 Bypass Quick stop。也可以通过一直激活的数字量输入初

始化功能实现。 
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5 变频器控制的标准功能块 
功能块每次用于一个含有两个 AS-I 从站的 G110D。AS-i 主站必须指定两个所分配

从站的地址。对于分配在 B 地址区域的从站，你可以加上 32 或 100 的偏移量。 
表 5-1 从站地址示例 

功能块参数值 (DEZ) 从站地址 
偏移量 32 偏移量 100 

 G110D 参数显示 
p2021[0,1] (HEX) 

1A 1 1 1 
1B 33 101 21 
14A 14 14 E 
17B 49 117 31 
30B 62 130 3E 

 
ON 命令将通过有效参数 Start_SPx 置位。你可以通过设置参数 p1001 – p1006 给

每个 ON 命令分配独立的固定频率值。万一有不止一个 ON 命令被激活，将应用最

高有效参数的固定频率值。 
 
表 5-2 ON 命令和固定频率示例 

实际参数 
 Start_SP… 

G110D 固定频率参数 [Hz] 激活 FF 

1 2 3 4 5 6 p1001 p1002 p1003 p1004 p1005 p1006 r1024 
x      50 -50 10 -10 70 -70 50Hz 
  x    -1,1 2,2 7,8 9 10 11 7,8Hz 
 x   x  10 -20 30 -40 50 -60 -20Hz 
x   x  x 10 15 20 25 30 35 10Hz 

 
图 5-1 STARTER 中设置固定频率 

 
 
通过参数 P1000=6，设定值通道可以改为模拟量给定。 
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5.1 AS-i 主站 CP34x-2(P) (FC/FB 143/243)的功能块 

对于每个 G110D，功能块 G110D_ASI_CTRL_343 将被调用一次。如果有从站是在

B 地址区域或想使用模拟通道，必须使用辅助功能块 G110D_ASI_AUX_343 。 

对于每个 AS-i 主站，此辅助功能块只需要调用一次。此调用使得主站管理的所有从

站可以使用附加功能。 
 
表 5-3 G110D_ASI_CTRL_343 (FC43)接口描述 

名称 数据类型 描述 
输入 
LADDR_ASi_Master WORD AS-i 主站的起始地址（16 进制格式） 

(256dez = 100hex) 
Slave_Address_1 INT X-从站的 AS-i 地址 (p2021[0]) 

在 B 地址区的从站必须添加偏移量； 
B 地址区只在“DB_No > 0”下被激活 

Slave_Address_2 INT Y-从站的 AS-i 地址 (p2021[1]) 
在 B 地址区的从站必须添加偏移量； 
B 地址区只在“DB_No > 0”下被激活 

DB_No INT 使用辅助功能块（FB43）时的实例 DB 块编号。 
当 “0” 功能不激活时。 

E_Stop BOOL 低电平信号，立即封锁脉冲 
Start_SP1 BOOL 以固定频率设定值 1 启动 (p1001) 
Start_SP2 BOOL 以固定频率设定值 2 启动 (p1002) 
Start_SP3 BOOL 以固定频率设定值 3 启动 (p1003) 
Start_SP4 BOOL 以固定频率设定值 4 启动 (p1004) 
Start_SP5 BOOL 以固定频率设定值 5 启动 (p1005) 
Start_SP6 BOOL 以固定频率设定值 6 启动 (p1006) 
Ack BOOL 故障确认 

Qs_dis BOOL 不使能快停 
AO_0 INT G110D 模拟输出 0 (0 – 200%) 

只在“DB_No > 0”下激活模拟量通道 
AO_1 INT G110D 模拟输出 1 (0 – 200%) 

只在“DB_No > 0”下激活模拟量通道 
输出 
Ready BOOL G110D 准备就绪 (r0052.0) 
Running BOOL G110D 正在运行 (r0052.2) 
DI_0 BOOL 本地数字输入 0 的状态 (r2067.0) 
DI_1 BOOL 本地数字输入 1 的状态 (r2067.1) 
DI_2 BOOL 本地数字输入 2 的状态 (r2067.2) 
DI_3 BOOL 本地数字输入 3 的状态 (r2067.3) 
AI_0 INT G110D 模拟输入 0 (0 – 200%) 

只在“DB_No > 0”下激活模拟量通道 
AI_1 INT G110D 模拟输入 1 (0 – 200%) 

 “DB_No > 0” 
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表 5-4 G110D_ASI1_CTRL_343 (FC143)接口描述 

名称 数据类型 描述 
输入 
LADDR_ASi_Master WORD AS-i 主站的起始地址（16 进制格式） 

(256dez = 100hex) 
Slave_Address INT AS-i 地址, 从站 2 (p2021[1]) 
E_Stop BOOL 低电平信号，立即封锁脉冲 
Start_SP1 BOOL 以固定频率设定值 1 启动 (p1001) 
Start_SP2 BOOL 以固定频率设定值 2 启动 (p1002) 
Start_SP3 BOOL 以固定频率设定值 3 启动 (p1003)) 
Start_SP4 BOOL 以固定频率设定值 4 启动 (p1004) 
Start_SP5 BOOL 以固定频率设定值 5 启动 (p1005) 
Start_SP6 BOOL 以固定频率设定值 6 启动 (p1006) 
Ack BOOL 故障确认 
输出 
Ready BOOL G110D 准备就绪 (r0052.0) 
Running BOOL G110D 正在运行 (r0052.2) 
DI_0 BOOL 数字量输入 0 状态 (r2067.0) 
DI_1 BOOL 数字量输入 1 状态 (r2067.1) 

 
AS-i 主站 CP 342-2 AS-i (订货号: 6GK7 342-2AH0x-0XA0) 既不支持 B 地址区域寻

址，也不支持通过模拟量通道传送数据。本例不能使用辅助功能块（这种情况）。 
 
为了缓解 CPU 与 CP 34x-2(P) 在背板总线上的数据交换压力， 可以单独激活独立

的辅助功能块。 
 
表 5-5 G110D_ASI_AUX_343 (FB243)接口描述 

名称 数据类型 描述 
输入 
LADDR_ASi_Master WORD AS-i 主站的起始地址（16 进制格式） 

(256dez > 100hex) 
Enable_DIO_B BOOL 为 AS-i 主站激活 B 地址区 
Enable_AI BOOL 激活 AS-i 从站的模拟输入 
Enable_AO BOOL 激活 AS-i 从站的模拟输出 

 
 

5.2 AS-i 主站 DP/AS-i Link (FC145/245/146/246)的功能块 

功能块 G110D_ASI_CTRL_CLC 和 G110D_ASI_CTRL_LIN 依照排序只能用于

DP/AS-i Links 。 

每个 AS-i 连接在过程映像区占用一个定义区域。被管理从站的顺序可以自由设定，

或者某种规则排序。取决于排序方法设置不同(经典或线性)，从站的控制位和状态位

在不同的位置。 

取决于通过功能块 G110D_ASI_CTRL_CLC (经典) 和 G110D_ASI_CTRL_LIN (线
性) 给出的排序方法， 可以不必知道 AS-i bits 的位置而访问 G110D。 
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图 5-2 DP/AS-i link 过程映像区配置 

 
 
如果在 HW configuration 中未做分类，将应用经典分类。在选择分类前，必须读出

或设置拓扑结构。 
表 5-6 G110D_ASI_CTRL_CLC/LIN (FC245/246)接口描述 

名称 数据类型 描述 
输入 
LADDR_ASi_Master WORD AS-i 主站的起始地址（16 进制格式） 

(256dez = 100hex) 
Slave_Address_1 INT 从站 1 的 AS-i 地址 (p2021[0]) 

在 B 地址区的从站必须添加偏移量； 
Slave_Address_2 INT 从站 2 的 AS-i 地址 (p2021[1]) 

在 B 地址区的从站必须添加偏移量； 
E_Stop BOOL 低电平信号，立即封锁脉冲 
Start_SP1 BOOL 以固定频率设定值 1 启动 (p1001) 
Start_SP2 BOOL 以固定频率设定值 2 启动 (p1002) 
Start_SP3 BOOL 以固定频率设定值 3 启动 (p1003) 
Start_SP4 BOOL 以固定频率设定值 4 启动 (p1004) 
Start_SP5 BOOL 以固定频率设定值 5 启动 (p1005) 
Start_SP6 BOOL 以固定频率设定值 6 启动 (p1006) 
Ack BOOL 故障确认 
Qs_dis BOOL 旁路快停 
输出 
Ready BOOL G110D 准备就绪(r0052.0)  
Running BOOL G110D 正在运行(r0052.2)  
DI_0 BOOL 本地数字输入 0 的状态 (r2067.0)  
DI_1 BOOL 本地数字输入 1 的状态 (r2067.1)  
DI_2 BOOL 本地数字输入 2 的状态 (r2067.2)  
DI_3 BOOL 本地数字输入 3 的状态 (r2067.3)  
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表 5-7 G110D_ASI1_CTRL_CLC/LIN (FC145/146)接口描述 

名称 数据类型 描述 
输入 
LADDR_ASi_Master WORD AS-i 主站的起始地址（16 进制格式） 

(256dez = 100hex) 
Slave_Address INT AS-i 地址, 从站 2p2021[1]) 
E_Stop BOOL 低电平信号，立即封锁脉冲 
Start_SP1 BOOL 以固定频率设定值 1 启动 (p1001) 
Start_SP2 BOOL 以固定频率设定值 2 启动 (p1002) 
Start_SP3 BOOL 以固定频率设定值 3 启动 (p1003) 
Start_SP4 BOOL 以固定频率设定值 4 启动 (p1004) 
Start_SP5 BOOL 以固定频率设定值 5 启动 (p1005) 
Start_SP6 BOOL 以固定频率设定值 6 启动 (p1006) 
Ack BOOL 故障确认 
输出 
Ready BOOL G110D 准备就绪(r0052.0) 
Running BOOL G110D 正在运行(r0052.2) 
DI_0 BOOL 本地数字输入 0 的状态 (r2067.0) 
DI_1 BOOL 本地数字输入 1 的状态 (r2067.1) 

 
 

5.3 AS-i 主站独立功能块 (FC144/244) 

独立于主站应用，你可以自己控制一个状态字，并提供给功能块

G110D_ASI_CTRL。AS-i 各个位必须按照下列顺序传输： 
 
表 5-8  AS-i 各位顺序 

实际参数 ASI_DIN 和 ASI_DOUT 
7 6 5 4 3 2 1 0 

双从站 
从站 2 的 AS-i 位 从站 1 的 AS-i 位 

3 2 1 0 3 2 1 0 
单从站 

从站 2 的 AS-i 位 从站 1 的 AS-i 位 
3 2 1 0 - - - - 
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表 5-9 G110D_ASI_CTRL (FC44)接口描述 

名称 数据类型 描述 
输入 
G110D_DOUT BYTE G110D 数字 AS-i 输出 

E_Stop BOOL 低电平信号，立即封锁脉冲 
Start_SP1 BOOL 以固定频率设定值 1 启动 (p1001) 
Start_SP2 BOOL 以固定频率设定值 2 启动 (p1002) 
Start_SP3 BOOL 以固定频率设定值 3 启动 (p1003) 
Start_SP4 BOOL 以固定频率设定值 4 启动 (p1004) 
Start_SP5 BOOL 以固定频率设定值 5 启动 (p1005) 
Start_SP6 BOOL 以固定频率设定值 6 启动 (p1006) 
Ack BOOL 故障确认 
Qs_dis BOOL 不使能快停 
输出 
G110D_DIN BYTE G110D 数字量 AS-i 输入 
Ready BOOL G110D 准备就绪(r0052.0) 
Running BOOL G110D 正在运行 (r0052.2) 
DI_0 BOOL 本地数字输入 0 的状态 (r2067.0) 
DI_1 BOOL 本地数字输入 1 的状态 (r2067.1) 
DI_2 BOOL 本地数字输入 2 的状态 (r2067.2) 
DI_3 BOOL 本地数字输入 3 的状态 (r2067.3) 

 
表 5-10 G110D_ASI1_CTRL (FC144)接口描述 

名称 数据类型 描述 
输入 
G110D_DOUT BYTE G110D 数字量 AS-i 输出 
E_Stop BOOL 低电平信号，立即封锁脉冲 
Start_SP1 BOOL 以固定频率设定值 1 启动 (p1001) 
Start_SP2 BOOL 以固定频率设定值 2 启动 (p1002) 
Start_SP3 BOOL 以固定频率设定值 3 启动 (p1003) 
Start_SP4 BOOL 以固定频率设定值 4 启动 (p1004) 
Start_SP5 BOOL 以固定频率设定值 5 启动 (p1005) 
Start_SP6 BOOL 以固定频率设定值 6 启动 (p1006) 
Ack BOOL 故障 
输出 
G110D_DIN BYTE G110D 数字量 AS-i 输入 
Ready BOOL G110D 准备就绪(r0052.0) 
Running BOOL G110D 正在运行 (r0052.2) 
DI_0 BOOL 本地数字输入 0 的状态 (r2067.0) 
DI_1 BOOL 本地数字输入 1 的状态 (r2067.1) 
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6 参数化的标准功能块 
参数化功能块内部调用通讯功能块 ASi_3422 (FC7)。 FC7 本身应用系统功能

WR_REC 和 RD_REC (SFC58/59)。不能同时多次调用这些非周期通讯功能块，注

意使用互锁来防止这种情况发生。 

非周期任务将从 CPU 传送到 AS-i 主站。主站接管从站的通讯。由于总线结构简

单，通讯以低传输速率进行。任务处理持续时间会随连接从站数显著增加。当满载

时（62 个从站），通过 FB247 传送一组数据需要几分钟时间。 

6.1 写数据组功能块 (FB247) 

功能块 G110D_ASI_WR_DS 把一整套数据组传送给 G110D。数据组包含的数据列

在数据结构 G110D_ASI_DS_CONF (UDT47)中。数据结构包含调试 G110D 所需的

全部参数。为了初次调试和设备更换，应该很好的配置此数据结构。 
 

注意 在数据传输之前，G110D 必须进行工厂复位。所有完成的修改将丢失。 

 
 
数据结构可在任意数据块中多次调用。在 DB_No 中必须指定数据块的序号。偏移量

指定了数据组的起始地址，这些数据组需要下载。(本例: motor1 为 0 而 motor2 为

106)。 
 
图 6-1 偏移量设定 

 
 
在 LAD/STL/FBD  编辑器中，你可以通过“View > Data view”来改变查看方式。在

“Actual value” 列，你可以输入所需参数值。. 
 
在实际参数 RetVal 中，你可以看到任务的当前状态。 
表 6-1 RetVal 的解释 

值(HEX) 意义 
8000 任务成功完成 
8800 任务因故障取消 
81xx 任务正在执行 

xx 状态进度 [%]  
可能值: 0 to 64 （16 进制） 对应 0 to 100 （10 进制）  
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表 6-2 G110D_ASI_WR_DS (FB247)接口描述 

名称 数据类型 描述 
输入 
LADDR_ASi_Master WORD AS-i 主站的起始地址（16 进制格式） 

(256dez > 100hex) 
Slave_Address_1 INT 从站 1 的 AS-i 地址(p2021[0]) 

在 B 地址区的从站必须添加偏移量 
DB_No INT 数据组存放的数据块编号 (UDT247)  
Offset INT 数据组的起始地址 
Enable BOOL 初始化写入选择的数据组 
输出 
Done BOOL 任务完成 
RetVal WORD 任务状态返回值 
输入_输出 
Status_ASi_3422 DWORD 通讯状态 (FC7)  

在相关文档描述 

 
 

6.2 读取和写入单个参数的功能块 (FB248) 

功能块 G110D_ASI_RD_WR_PAR 可以读取和写入任意参数。可用参数列表在相关

文档中。 
 
G110D 既有 16 位参数也有 32 位参数。整数或 Bit 列需要 16Bit。他们在实际参数

Value_WR 和 Value_RD 的位 0 到位 15 被存储或读取。浮点数(IEEE754) 或混合参

数 (BiCo) 需要 32 位。16 至 32 位代表参数号，位 0 to 15 代表了需要结合参数的索

引。 
 

注意 参数的二进制结合可由固定值 FALSE 和 TRUE 来指定。若是 FALSE，需要输入

值 DW#16#0 ，若是 TRUE，需要输入值 DW#16#10000 。 

 
 

 
 

示例 1: 

修改第一个固定频率参数 r1001[0] 至 40.5Hz。 
Par_No: 1001   Par_Type: TRUE 
Par_Index: 0   Value_WR: 40.5 (REAL) 
 

示例 2: 

通过第二个模拟量通道 p2061[1] 传送故障存储器 r0947 (03B3 HEX) 中第 15 个故障

代码。 
Par_No: 2061   Par_Type: TRUE 
Par_Index: 1   Value_WR: 03B3 000F (HEX) 
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表  6-3  G110D_ASI_RD_WR_PAR (FB248)接口描述 

名称 数据类型 描述 
输入 
LADDR_ASi_Master WORD AS-i 主站的起始地址（16 进制格式） 

(256dez > 100hex) 
Slave_Address_1 INT 从站 1 的 AS-i 地址(p2021[0]) 

在 B 地址区的从站必须添加偏移量 
Par_No INT 将要写入或读取的参数号 
Par_Index INT 所选参数的索引号 
Par_Type BOOL 0: 所选参数是 16 Bit  

1: 所选参数是 32 Bit  
Eeprom BOOL 0: 将要写入 RAM 的值(Value_WR)  

1: 将要写入 EEPROM 的值 (Value_WR)  
Value_WR DWORD 将要写入所选参数的值 
Enable_RD BOOL 初始化读取所选参数 
Enable_WR BOOL 初始化写入所选参数 
输出 
Busy BOOL 任务正在处理 
Done BOOL 任务成功完成 
Error BOOL 任务因故障取消 
Value_RD DWORD 从所选参数读取值 
IN_OUT 
Status_ASi_3422 DWORD 通讯状态 (FC7)  

在相关文档描述 
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7 附录 
 

7.1 规范链接 

表 7-1 规范链接 

 主题 标题 

\1\ 常问问题 What restrictions are there for active jobs when 
communicating with SFC 58 / SFC 59 and SFB 52 / 
SFB 53 via PROFIBUS DP and PROFINET IO?

\2\ 操作手册 M200D AS-i

\3\ 参考手册 AS-Interface • IO-Link • PROFIBUS

\4 调试工具 STARTER

\5 参考手册 SINAMICS G110D

 

7.2 历史 

表 7-2 历史 

版本 日期 更改 

V1.0 2010/03/18 第一版 

V1.1 2010/11/11 插入单/双模式 

   

 

http://support.automation.siemens.com/WW/view/en/15364459
http://support.automation.siemens.com/WW/view/en/15364459
http://support.automation.siemens.com/WW/view/en/15364459
http://support.automation.siemens.com/WW/view/en/36846576
http://support.automation.siemens.com/WW/view/en/36185027
http://support.automation.siemens.com/WW/view/en/10804985/133100
http://support.automation.siemens.com/WW/view/en/37316373
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